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2.05.07

Release Summary
This software release allows Fusion 2 to successfully convert a position, from a geographic WGS 84 position, toa UTM
Zone 30N projected position such as ‘ED50 / UTM Zone 30N’.

Hardware
The following PC specifications are required as a minimum:

Component Specification
Processor Core i7 2.4GHz
System Firmware UEFI (for Unified Extensible Firmware Interface, a modern version of the PC BIOS)

and Secure Boot capable. Secure Boot can only be enabled with UEFI and this article
helps you understand potential options to change settings to make this possible.

TPM Trusted Platform Module (TPM) version 2.0.
Graphics Card 32-bit colour, minimum 1280 x 1024. Compatible with DirectX 12 or later with
WDDM 2.0 driver.
Memory (RAM) 8GB
Storage (SSD/HDD) Minimum 256GB, recommended 512GB to support data storage
Operating System Windows 10 x64, Windows 11
Firmware

The following instrument firmware versions are the minimum versions which should be installed in each component
for use with this software release. Please note that more recent firmware versions may be available and installed on
new equipment, there is no requirement to downgrade these instruments for use with Fusion 2

Navigation Sensor Hub (NSH) 2.0.3.107
SPRINT Firmware 3.07.00.2139
Syrinx Firmware 3.02.40.00 (Rel2_rev))
ROVNav 6+ LBL Transceiver 3.13.00.07
Compatt 6+ LBL Transponder (CPU) 3.13.01.03
Compatt 6+ LBL Transponder (DAS) 2.06N
MiniROVNav 6+ 3.13.01.03
MicroCompatt 6+ 3.13.01.03
Lodestar Gyro Compatt 6+ (CPU) 3.12.07.13
Lodestar Gyro Compatt 6+ (Lodestar) 3.02.01
Software

The following associated software versions have been tested with this release. As a minimum, these versions must be
installed when used with this release of Fusion 2:

Package Software Version
Janus 1.06.01.14

New Features
Ref Functional Area Description
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Bug Fixes
For more details on any of the fixes below please contact Sonardyne customer support.

Ref Functional Area | Description

36354, 36448 | Geodesy Allow successful position conversions from geographic CRS ‘WGS 84’ to
projected CRS ‘ED50/UTM Zone 30N’

Known Issues

Ref | Functional Area

35986 | Tracking Slow memory accumulation during prolonged (24Hr+) structure tracking

Note: Versions of Fusion 2 after 2.04.00 do not install/run on Windows 7. For more information on Windows 7
please contact Sonardyne customer support, using the details at the end of these release notes.
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2.05.06

Release Summary
This software release provides the option to prevent Fusion 2 from changing the baud rate of a transceiver in
situations where the connection doesn’t support dynamic baud rate changes.

Hardware
The following PC specifications are required as a minimum:

Processor Corei7 2.4GHz

System Firmware UEFI (for Unified Extensible Firmware Interface, a modern version of the PC BIOS)
and Secure Boot capable. Secure Boot can only be enabled with UEFI and this article
helps you understand potential options to change settings to make this possible.

TPM Trusted Platform Module (TPM) version 2.0.
Graphics Card 32-bit colour, minimum 1280 x 1024. Compatible with DirectX 12 or later with
WDDM 2.0 driver.
Memory (RAM) 8GB
Storage (SSD/HDD) Minimum 256GB, recommended 512GB to support data storage
Operating System Windows 10 x64, Windows 11
Firmware

The following instrument firmware versions are the minimum versions which should be installed in each component
for use with this software release. Please note that more recent firmware versions may be available and installed on
new equipment, there is no requirement to downgrade these instruments for use with Fusion 2

Instrument Firmware Version

Navigation Sensor Hub (NSH) 2.0.3.107
SPRINT Firmware 3.07.00.2139
Syrinx Firmware 3.02.40.00 (Rel2_rev))
ROVNav 6+ LBL Transceiver 3.13.00.07
Compatt 6+ LBL Transponder (CPU) 3.13.01.03
Compatt 6+ LBL Transponder (DAS) 2.06N
MiniROVNav 6+ 3.13.01.03
MicroCompatt 6+ 3.13.01.03
Lodestar Gyro Compatt 6+ (CPU) 3.12.07.13
Lodestar Gyro Compatt 6+ (Lodestar) 3.02.01
Software

The following associated software versions have been tested with this release. As a minimum, these versions must be
installed when used with this release of Fusion 2:

Janus 1.06.01.14

New Features

Ref Functional Area

36150,35142,3 | Instruments Add control to prevent automatic baud rate changes
6151
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Functional Area Description

36150 Add control to prevent automatic baud rate changes

Note

[N
Fusion 2 can only reset a transceiver by briefly changing its baud rate to 9600, sending a break sequence before
restoring the baud rate that the transceiver is configured to use. Disabling the ability to change baud rate will require
the transceiver to be reset manually by cycling its power.

Some multiplexors, and serial hubs do not support dynamic baud rate changing, and this can cause connection
problems to transceiver if Fusion2 attempts to reset the transceiver to restore it to a known condition. This new
option controls whether, or not Fusion 2 will change the baud rate of the transceiver.
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Bug Fixes
For more details on any of the fixes below please contact Sonardyne customer support.

Ref Functional Area | Description

Known Issues

Ref | Functional Area

35986 | Tracking Slow memory accumulation during prolonged (24Hr+) structure tracking

Note: Versions of Fusion 2 after 2.04.00 do not install/run on Windows 7. For more information on Windows 7
please contact Sonardyne customer support, using the details at the end of these release notes.
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2.05.05

Release Summary

This software release provides the ability to scale baselines and ranges for compatibility with historical surveys. It also
provides LNAVUTC output reports, and many performance and reliability improvements, addressing issues found in
earlier versions of the software following customer feedback.

Hardware
The following PC specifications are required as a minimum:

Processor Corei7 2.4GHz

System Firmware UEFI (for Unified Extensible Firmware Interface, a modern version of the PC BIOS)
and Secure Boot capable. Secure Boot can only be enabled with UEFI and this article
helps you understand potential options to change settings to make this possible.

TPM Trusted Platform Module (TPM) version 2.0.
Graphics Card 32-bit colour, minimum 1280 x 1024. Compatible with DirectX 12 or later with
WDDM 2.0 driver.
Memory (RAM) 8GB
Storage (SSD/HDD) Minimum 256GB, recommended 512GB to support data storage
Operating System Windows 10 x64, Windows 11
Firmware

The following instrument firmware versions are the minimum versions which should be installed in each component
for use with this software release. Please note that more recent firmware versions may be available and installed on
new equipment, there is no requirement to downgrade these instruments for use with Fusion 2

Instrument Firmware Version

Navigation Sensor Hub (NSH) 2.0.3.107
SPRINT Firmware 3.07.00.2139
Syrinx Firmware 3.02.40.00 (Rel2_rev))
ROVNav 6+ LBL Transceiver 3.13.00.07
Compatt 6+ LBL Transponder (CPU) 3.13.01.03
Compatt 6+ LBL Transponder (DAS) 2.06N
MiniROVNav 6+ 3.13.01.03
MicroCompatt 6+ 3.13.01.03
Lodestar Gyro Compatt 6+ (CPU) 3.12.07.13
Lodestar Gyro Compatt 6+ (Lodestar) 3.02.01
Software

The following associated software versions have been tested with this release. As a minimum, these versions must be
installed when used with this release of Fusion 2:

Janus 1.06.01.14

10
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New Features

Ref Functional Area Description

35373,35902,3 | Calibration Scale factor display and application

5828,35832,35

836,35890,359

87

35863,35865 Calibration Collect all baselines from one beacon before moving to next

35574 Calibration Prompt user to generate snapshot (f21z) from a calibration

35575 Calibration Box-in report to show engine settings

35592 Calibration Box-in reprocessing tool to show vessel track

36011 Calibration Correct transceiver positions in box-in XML report

35302 Environment Change the default update rate for SV when beacon is selected as SV
sensor

35295 Instruments Add the ability to output Client and Server TCP outputs

35850 Instruments Ensure only TCP Server output is offered from Gen3 SPRINT

35837 Instruments GGA Decode: Allow alphanumeric StationID

35488, 35582 | Instruments Add support for LNAVUTC output

35650,35835,3 | All Stability, security and usability improvements

5812,35834,35

864,35933

35373 Scale factor display and application

Note

[% Fusion 2 does not require scaling. Altering these values will cause all ranges and baselines to be scaled. Only apply a
scale factor if specifically required by the survey.

Fusion2 computes positions using Earth-centred, Earth-fixed (ECEF) co-ordinates, and so only uses UTM coordinates
for display and user input purposes. As such it does not use a projection scale-factor. Sometimes when tying new
Locations into an existing array, it is necessary to adjust the scaling of baseline and range observations to make new
measurements fit the existing calibrated co-ordinates. The Scaling tab allows the operator to view what the
equivalent projection and elevation scale-factor is at the centre of the array, and at the average depth. They can then
calculate an ‘Adjustment multiplier for specific survey’ that will be used to scale measured ranges to achieve a
required effective ‘Survey specific scale-factor’. In addition, the tab provides an ‘Adjustment multiplier for
environment’ which can be used to correct bias in sound speed.

11
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35863 Collect all baselines from one beacon before moving to next

The baseline collection order has been modified to collect all baselines from a single beacon before moving on to the
next beacon. This allows for the vehicle collecting the baseline telemetry to be moved during the collection to
optimise the acoustic link and improve the telemetry.

35574 Prompt user to generate snapshot (f2Iz) from a calibration
Force operator to decide whether a calibration snapshot is required to support calibration reprocessing.

35575 Box-in report to show engine settings
Add the configured box-in engine settings in calibration report.

35592 Box-in reprocessing tool to show vessel track
Show the approximate vessel track that was sailed during box-in data collection when reprocessing the calibration.

35302 Change the default update rate for SV when beacon is selected as SV sensor
When using measured sound speed from a beacon, set the default update period to 10 minutes.

35295 Add the ability to output Client and Server TCP outputs
All output connections to be served by either Fusion 2, or a remote source.

35850 Ensure only TCP Server output is offered from Gen3 SPRINT
When using a SPRINT as the source of an output telegram the TCP connection the SPRINT has to be the server.

35837 GGA Decode: Allow alphanumeric StationID
Relax syntax on NMEA 0187 GGA telegram decode to allow the StationID to be alpha-numeric to allow modern
receivers to indicate the type of solution.

12
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35488 Add support for LNAVUTC output
Provide an interface to allow the SPRINT LNAVUTC output to be configured.

Bug Fixes

For more details on any of the fixes below please contact Sonardyne customer support.

Ref Description

35647 Calibration Cannot reprocess baseline cal where beacons are moved between collections

35559 Calibration Duplication of locations in reprocessing tool

35560 Calibration Box in export failure to load

35563 Calibration Box in snapshot report not created correctly

35569 Calibration Custom geodesy not pulled through in snapshot files

35590 Calibration Calibration not processing due to time drift

35649 Calibration Store a Job Observation for the complete job at the end of a baseline
calibration snapshot

35660 Calibration Survey doesn't re-load after re-processing

35842 Calibration Box in does not generate a report

35848 Calibration Baseline Calibration Diagnostics locations all orange

35866, 35553 | Calibration Automatic CIS enabling on Boxin not working

35889 Calibration Please apply the same formatting and sorting to Locations column in
calibration results as happens in Locations table.

35892,35893 | Calibration Baseline Calibration Report Not Generated

35931 Calibration Calibration planning window spawning and not releasing threads

35957 Calibration Calibration reprocessing does not complete on the attached file

35385 Calibration Incorrect projected CRS code in xml reports

36011 Calibration Correct transceiver positions in boxin XML report

35461,35973 Environment Sound velocity not calculated if ROV depth outside profile range

35345 Instruments Auto telemetry setting uses first Transceiver

35215 Instruments Limit TPL power level if battery is Alkaline (Implement TB17-003)

35878 Instruments Send wake up tone on any user instigated telemetry

35460 Instruments Fusion 2 not setting ROVNav SPL level?

35867 Instruments Output Telegram: Comms source reverts to PC after selecting SPRINT until
Application restart

35887 Instruments Comms coming through after F2 restart on disabled vehicle

35962 Instruments Missing factory calibration alarm raised incorrectly

35955 Instruments Time source configuration not saved

35202 Instruments [SN] SSB setting kept after deleting - if GGA is then added the aiding is rejected

35912 Instruments Generic DVL baud rate isn't saved and therefore incorrect after resetting the
SPRINT

35956 Instruments log message not saved to SPRINT configuration file - OINSCOR

35976 Instruments Output not configured (TSS1) - due to DVLPD4PD5 being set on OP command

35909 Instruments No output when selecting to output a PRDDIGIQ M to a serial port

35487 User Interface Enabled showing greyed out

35662 User Interface Reply option is blank for a beacon in table

35840 User Interface Disable does not persist with close and reopen

35847 User Interface Unable to assign beacons in the locations table

35937 User Interface External solution depth red on nav status

35942 User Interface Text display for GNSS data doesn't show correctly

35905,35341,3 | All Stability and usability (Resource monitor warnings)

5462,35529,35

13
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Ref Functional Area | Description
631,35638,358
45,35849,3586
9,35870,35873
,35882,35883,
35885,35958,3
5967,35970,35
972,35982,359
85

Known Issues

Ref Functional Area Description
35986 | Tracking Slow memory accumulation during prolonged (24Hr+) structure tracking

Note: Versions of Fusion 2 after 2.04.00 do not install/run on Windows 7. For more information on Windows 7
please contact Sonardyne customer support, using the details at the end of these release notes.

IS
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2.05.04

Release Summary
This software release provides improved performance and reliability, addressing an issue found in earlier versions of
the software following customer feedback.

Hardware
The following PC specifications are required as a minimum:

Component Specification

Processor Corei7 2.4GHz

System Firmware UEFI (for Unified Extensible Firmware Interface, a modern version of the PC BIOS)
and Secure Boot capable. Secure Boot can only be enabled with UEFI and this article
helps you understand potential options to change settings to make this possible.

TPM Trusted Platform Module (TPM) version 2.0.
Graphics Card 32-bit colour, minimum 1280 x 1024. Compatible with DirectX 12 or later with
WDDM 2.0 driver.
Memory (RAM) 8GB
Storage (SSD/HDD) Minimum 256GB, recommended 512GB to support data storage
Operating System Windows 10 x64
Firmware

The following instrument firmware versions are the minimum versions which should be installed in each component
for use with this software release. Please note that more recent firmware versions may be available and installed on
new equipment, there is no requirement to downgrade these instruments for use with Fusion 2

Navigation Sensor Hub (NSH) 2.0.3.107
SPRINT Firmware 3.07.00.2139
Syrinx Firmware 3.02.40.00 (Rel2_rev))
ROVNav 6+ LBL Transceiver 3.12.08.09
Compatt 6+ LBL Transponder (CPU) 3.13.01.03
Compatt 6+ LBL Transponder (DAS) 2.06N
MiniROVNav 6+ 3.12.08.09
MicroCompatt 6+ 3.13.01.03
Lodestar Gyro Compatt 6+ (CPU) 3.12.07.13
Lodestar Gyro Compatt 6+ (Lodestar) 3.02.01
Software

The following associated software versions have been tested with this release. As a minimum, these versions must be
installed when used with this release of Fusion 2:

Package Software Version
Janus 1.06.01.14

New Features

Ref

15
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Ref Functional Area Description

Bug Fixes
For more details on any of the fixes below please contact Sonardyne customer support.

Functional Area Description

Stability 35548 Error disposing of EM1000, EM3000 and PRDKELBIN telegrams

Known Issues

Ref | Functional Area

35437 | Calibration Screen glitch — popup box now fully populated

35438 | Stability SharpDX exception on Fusion 2 shutdown

35442 | Alarms ZDA alarm every minute

35443 | Sensors Depth offset of external aiding source changed to internal sensor offset
35444 | Solutions Unable to select different depth source for external solution

35413 | Sensors SPRINT loops while trying to change ports.

Note: Versions of Fusion 2 after 2.04.00 do not install/run on Windows 7. For more information on Windows 7
please contact Sonardyne customer support, using the details at the end of these release notes.

16
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2.05.03

Release Summary
This scheduled software release provides new software functionality, improved performance and reliability, addresses

issues found in earlier versions of the software and implements usability improvements in line with customer
feedback.

Significant new additions and changes include:

e Addition of range test tool that facilitates tuning power and gain
e Changes to reduce the number of Alarms that get raised
e Bug fixes, plus performance and stability improvements

Hardware
The following PC specifications are required as a minimum:

Processor Corei7 2.4GHz

System Firmware UEFI (for Unified Extensible Firmware Interface, a modern version of the PC BIOS)
and Secure Boot capable. Secure Boot can only be enabled with UEFI and this article
helps you understand potential options to change settings to make this possible.

TPM Trusted Platform Module (TPM) version 2.0.
Graphics Card 32-bit colour, minimum 1280 x 1024. Compatible with DirectX 12 or later with
WDDM 2.0 driver.
Memory (RAM) 8GB
Storage (SSD/HDD) Minimum 256GB, recommended 512GB to support data storage
Operating System Windows 10 x64
Firmware

The following instrument firmware versions are the minimum versions which should be installed in each component
for use with this software release. Please note that more recent firmware versions may be available and installed on
new equipment, there is no requirement to downgrade these instruments for use with Fusion 2

Navigation Sensor Hub (NSH) 2.0.3.107
SPRINT Firmware 3.07.00.2139
Syrinx Firmware 3.02.40.00 (Rel2_rev))
ROVNav 6+ LBL Transceiver 3.12.08.09
Compatt 6+ LBL Transponder (CPU) 3.13.01.03
Compatt 6+ LBL Transponder (DAS) 2.06N
MiniROVNav 6+ 3.12.08.09
MicroCompatt 6+ 3.13.01.03
Lodestar Gyro Compatt 6+ (CPU) 3.12.07.13
Lodestar Gyro Compatt 6+ (Lodestar) 3.02.01
Software

The following associated software versions have been tested with this release. As a minimum, these versions must be
installed when used with this release of Fusion 2:
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Janus 1.06.01.14

New Features

Ref Functional Area Description

35147 | Ranging Created a Range Test tool
35159 | Tracking Allow multiple GNSS devices (one per vehicle)

35147 Create a Range Test tool

This tool allows ranges between a transceiver and a beacon, or between 2 beacons to be collected a given number of
times. The tool will display the arithmetic mean, and standard deviation of the received ranges, but also shows the
received signal metrics which can be useful for tuning the required gain, and power level to achieve stable ranging.

Refer to the operator’s manual for details of how to tune the received signal quality metrics.
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Bug Fixes
For more details on any of the fixes below please contact Sonardyne customer support.

Functional Area Description

Alarms 35059 New alarm when SPRINT connection quality is poor

Alarms 35192 When using two dongles (for INS and LBL packs), if one expired, the user
was not notified

Alarms 35230 Clarified alarm when SV input is in error

Alarms 35309 Clear vehicle alarms when it is disabled.

Alarms 35318 Add an alarm when IMU not working.

Alarms 35332 Only raise a 'Not configured to 6+' alarm on a device that is positively
reports that it is not 6+.

Alarms 35335 Raise an alarm if the connected transceiver is not set to 38400

Alarms 35358 Only raise critical 'battery low alarm' with beacons

Beacons 35215 Limit TPL if battery is alkaline, and less than 50% remaining

Calibration 35161 Incorrect SV from profile displayed during Box-In calibration.

Calibration 35208 Real Time Calibration: Corrected histogram not populating when viewing
baseline

Calibration 35212 Calibration Reprocessing: Stopped raising duplicate warning messages
when importing data

Calibration 35217 Corrected issue that could cause Live Calibration and Post Processing
result difference

Calibration 35337 Calibration Reprocessing: Load multiple Baseline snapshots.

Outputs 35242 Output configured on a different TCP port than requested

Outputs 35247 CRP offset was not being applied to outputs

Outputs 35253 Output list port options were blank

Outputs 35267 Can now redirect configured sprint output message from one socket to
another

Outputs 35274 Output message wasn't being added to SPRINT ethernet port

Outputs 35298 Output reports not set after selecting the required configuration and no
output observed

Ranging 35245 Corrected ZDA time sync issue that caused LBL ranging failure.

Ranging 35316 Ensure that AT and EC not set to O while tracking

Ranging 35360 Allow raw comms export in LBL only setup with no SV

Ranging 35387 Prevent array beacon error state stopping ROV tracking

Ranging 35392 Only send 'Wake up' tone after 'Activity Time' expires

Security 35190 Corrected inconsistent baseline options

Security 35227 Updated F2 Installer Licensing Tool prerequisite

Sensors 35164 Protect SPRINT NAV aiding sensor settings on port switch

Sensors 35218 Prevent port snoop on UART 4 (DVL) causing data overload

Sensors 35219 SPRINTNav pressure data was not sent to the unit until you added
position data

Sensors 35220 DVL settings weren't reset correctly or configured on connection with
SPRINTNav

Sensors 35226 Corrected SPRINTNav pressure status light seen on connection

Sensors 35228 Removed spurious 'Corrupted data' message for not connected/disabled
SPRINT.
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Functional Area | Ref Description
Sensors 35232 SYS SAVE FLASH timeout corrected.
Sensors 35233 Commands held off during UART break command
Sensors 35234 SPRINT Zero: Not Populating Information
Sensors 35236 Config file wasn't being sent down to SPRINT
Sensors 35255 Configure time system when you switch SPRINT from serial to Ethernet
connection
Sensors 35264 DVL output is now being correctly removed from log list
Sensors 35265 Correct PD4 DVL log output message
Sensors 35266 Improved SPRINTNAV connection state monitoring
Sensors 35379 Prevented Ul refresh reverting edited UDP address when making changes
Sensors 35410 SPRINTNav Power Pass Ul corrected.
Sensors 35277 Corrected SPRINTNav lever arms and offsets persistence
Sensors 35413 Corrected logic so that incoming beacon sound speed is used when
selected
Sensors 35436 Force beacon sound speed to be used when selected.
Telemetry 35199 Measurement configuration options were not turning off reliably.
Telemetry 35225 Stop measurement collection attempts continue indefinitely on
uncontactable beacon
Telemetry 35393 Commands were sometimes sent from wrong transceiver
Telemetry 35428 Discovery should pick the next available transceiver
ul 35157 Correct missing unit conversions
ul 35171 Shortening a location name was not recognised as a change - now allows
‘Apply’
ul 35194 Average Fix Tool: Change 'Run’' button to 'Start’
ul 35216 Geodesy details were not showing in summary
ul 35221 LEDs on rov with SPRINTNav didn't represent the situation
ul 35222 Display Heading in both Geographic, and Projected display modes
ul 35229 Navigation status display was showing acoustic items which were not
selected for ranging
ul 35235 Corrected bug producing aiding charts in leap years.
ul 35270 Selecting an output port for 1pps+ZDA didn't fit on the form
ul 35272 Wrong Nav status was displayed when vehicle disabled
ul 35320 Corrected Ul internal offset to match SPRINTNav
ul 35356 Noise plots from difference RovNavs were showing the same data.
ul 35361 Navigation status display was missing when multiple solutions active
All areas 35162, 35165, 35170, | Performance and stability improvements (39 changes)
35174, 35189, 35195,
35203, 35209, 35210,
35224, 35237, 35240,
35244, 35248, 35258,
35260, 35262, 35263,
35268, 35269, 35273,
35278, 35279, 35280,
35281, 35293, 35304,
35324, 35330, 35331,
35359, 35396, 35416,
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Functional Area Description
35417, 35418, 35421,
35423, 35441, 35446,

35179
Known Issues
Ref Functional Area Description
35437 | Calibration Screen glitch — popup box now fully populated
35438 | Stability SharpDX exception on Fusion 2 shutdown
35442 | Alarms ZDA alarm every minute
35443 | Sensors Depth offset of external aiding source changed to internal sensor offset
35444 | Solutions Unable to select different depth source for external solution
35413 | Sensors SPRINT loops while trying to change ports.

Note: Versions of Fusion 2 after 2.04.00 do not install/run on Windows 7. For more information on Windows 7
please contact Sonardyne customer support, using the details at the end of these release notes.
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2.05.02

Release Summary

This software release implements a small selection of new features to support customers’ operational needs, but
primarily focuses on significant improvement to the speed, efficiency, and stability of the software, to improve the
user experience and provide more robust communications with attached instruments.

New Features

Ref Functional Area Description

22858 | Calibration Reprocessing Implement an Eiva NaviModel compatible export of all baseline
calibration data.

35023 | Instrumentation Show SSB beacon code in USBL instrument data tab.

35025 | Security Key Update DESKey DK2 drivers to v8.21.24.

35029 | User Interface Allow control of DVL aiding status for SPRINT-Nav via the Navigation
Status Display.

35044 | Calibration Reprocessing Provide ability to edit turn-around-times for baselines.

35045 | Calibration Reprocessing Provide tabulated historic SV data for available sources.

35047 | Calibration Reprocessing Provide ability to select different SV source configuration per calibration
dataset.
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22858 Implement an Eiva NaviModel Compatible Export of All Baseline Calibration Data

When a PDF report of a baseline calibration is generated, either from the Real-Time Calibration tool or the Calibration
Reprocessing tool, an XML file is now created and saved in the same directory as the PDF report. This file contains all
the necessary information for the baseline calibration to be reprocessed in Eiva’s NaviModel software, as a means of
comparing Fusion 2’s baseline adjustment results with an independent reference.

35044 Provide Ability to Override Baseline Turn Around Times in Calibration Reprocessing

It is now possible to override turn-around-times associated with baselines if it is known that an incorrect value has
been recorded. To do this, select one or more baselines in the Data tab in the Calibration Reprocessing tool, and right
click on the TAT (ms) column. Select Override Turn-Around-Time (TAT) in the context menu.

A dialog is shown, where a new value can be set for the selected baseline ranges.
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Any changes made via this method can be reset by reselecting the baseline ranges, right clicking on the TAT (ms)
column, and selecting Reset Turn-Around-Time (TAT) Override for selected ranges.

35045 Provide Tabulated Historic Sound Velocity Data for Sources During Calibration Reprocessing

While reprocessing calibration data, associated sound velocity can be viewed in a table when available. This
information can be viewed from within the Calibration Reprocessing tool by clicking the buttons in the View Data
column of the tables within the Sound Velocity tab.

14-2502

Ready to Calculate
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35045 Provide Ability to Select a Different Sound Velocity Source Configuration per Calibration Dataset

While reprocessing calibration datasets consisting of multiple individual collections, it is now possible to configure
each collection’s sound velocity sources separately. This may be useful when multiple sound velocity profiles are
available and are associated with specific calibration datasets. When multiple collections are imported to the
Calibration Reprocessing tool, the collection number for each baseline is visible in the Data table, and each
collection’s SV configuration can be edited by selecting its number in the drop-down menu before making changes to
the configured sources.

\ |
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Bug Fixes

For more details on any of the fixes below please contact Sonardyne customer support.

Functional Area Ref Description

Average Fix Tool 35012 Fix incorrect scaling of position error metrics

Alarms 35021 Alarm not raised when beacon telemetry fails

Box-in Calibration 35024 Box-in calibration of location using external Range Input (SSB)
fails to start if location already has a beacon assigned to it.

Acoustics 35027 Remove unnecessary MR commands being sent to beacons with
low battery which restricted their further use

Calibrations 35031 Sound velocity profile missing from calibration snapshot files

Data Export 35032 Raw Comms data export failing if instruments connected via
comms hub

Acoustic Instrumentation 35034 ROVNav information being overwritten by beacon information
while performing beacon telemetry.

Telemetry Diagnostics 35036 Some acoustic commands becoming stuck in telemetry
diagnostics display indefinitely

Box-in Calibration Reprocessing 35038 Incorrect method of calculating average sound speed for ranges
used for sound speed profiles in reprocessing of box-in
calibrations.

Box-in Calibration Reprocessing 35039 Software crash which could occur while reprocessing box-in
calibration data if live GNSS being supplied to the system

Baseline Calibration Reprocessing 35041 Calibration report generation failing if data is manually rejected

Calibration Reprocessing 35043 Incorrect behaviour of scroll bars in calibration reprocessing tool

Calibration Snapshots 35048 Some settings not being saved when snapshot of current
calibration state taken

Baseline Histogram Plots 35050 Incorrect plot scaling makes interpretation difficult

Calibration Snapshots 35052 Progress bar during snapshot generation not showing any
progress

Instrumentation 35054 ROVNav transceiver missing from system setup on software
restart

Acoustic Instrumentation 35062 High CPU usage in some circumstances if beacon ranging fails

Instrumentation: SPRINT 35071 Switching communications from serial to ethernet can cause
loss of input configuration

Instrumentation: SPRINT 35075 Instability of communications with SPRINT after extended
period of operation.

User Interface 35076 Depth segment of Navigation Status display incorrectly greyed
out in some circumstances

User Interface 35082 User interface unresponsive after extended period of operation
if manual command tool left open.

User Interface 35084 Instrument status lights in system setup page showing incorrect
connection status for DVL

Communications 35087 Communications to DVL connected via LCH lost if LCH power
cycled

Instrumentation: SPRINT 35090 Some commands and control of SPRINT causing user interface
to freeze.

Instrumentation: Syrinx 35091 Outputs from Syrinx auxiliary port incorrectly cleared by Fusion

2 during configuration
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Description

Instrumentation: iWand 35095 Unable to connect to iWand via serial/USB

Instrumentation 35102 Able to add multiple DVL instruments to a vehicle when only
one is supported

Security Key 35107 Security key read failure preventing software loading

User Interface 35112 User can move plot series which should be fixed to the axes in
aiding diagnostics chart

User Interface 35115 Instrument status lights in system setup page showing incorrect
connection status for some instruments after LCH power cycle

Instrumentation 35118 Synchronous communication time stamping strategy causing
comms buffering on systems under heavy load

Security Key 35119 Security key read failure causing system instability on long
running system

Telemetry Diagnostics 35122 Some pending actions not shown in acoustic telemetry
diagnostics window

Baseline Calibration Reprocessing 35123 Calibration reprocessing tool showing incorrect SD figure on
chart overlay in some circumstances when multiple datasets
loaded.

Box-in Calibration 35131 Box-in calibration failing to compute position for multiple
beacon calibrations under some circumstances.

User Interface 35151 Not possible to scroll list of vehicles/transceivers in SV

configuration page.

Note: Versions of Fusion 2 after 2.04.00 will not install/run on Windows 7. For more information on Windows 7
please contact Sonardyne customer support, using the details at the end of these release notes.
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2.05.01

Release Summary

This software release provides fixes to issues found in version 2.05.00 of the software.

Bug Fixes

For more details on any of the fixes below please contact Sonardyne customer support.

Functional Area

Beacon import 35016 CSV import fails if it includes beacons which have never been
interrogated.

Instrumentation / Beacons 35017 Tracking fails to start when loading legacy jobs where many
beacons have unknown CIS state.

Instrumentation / Transceivers 35018 Newly added transceivers can assume identity of other
transceivers in system if communication with them is not
immediately successful.

Instrumentation / Ranging 35022 Ranging can become slow when receiving more than 15 ranges

in one cycle (e.g., during some Fast-LBL structure tracking
scenarios).

Note: Versions of Fusion 2 after 2.04.00 will not install/run on Windows 7. For more information on Windows 7
please contact Sonardyne customer support, using the details at the end of these release notes.
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2.05.00

Release Summary

This scheduled software release provides new software functionality, improved performance and reliability, addresses
issues found in earlier versions of the software and implements usability improvements in line with customer
feedback.

Significant new additions and changes include:

e Additional acoustic diagnostics tools

e Expanded database management tools

e Support for external depth sensors with SPRINT-Nav INS instruments
e Additional depth data input formats

Hardware
The following PC specifications are required as a minimum:

Processor Core i7 2.4GHz

Memory (RAM) 8GB

Graphics Card 32-bit colour, minimum 1280 x 1024, Direct-X
V10 or later

Operating System Windows 10 x64
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Firmware

The following instrument firmware versions are the minimum versions which should be installed in each component

for use with this software release. Please note that more recent firmware versions may be available and installed on
new equipment, there is no requirement to downgrade these instruments for use with Fusion 2

Instrument

Firmware Version

Navigation Sensor Hub (NSH) 2.0.3.107

SPRINT Firmware 3.07.00.2139

Syrinx Firmware 3.02.40.00 (Rel2_rev))
ROVNav 6+ LBL Transceiver 3.12.08.09

Compatt 6+ LBL Transponder (CPU) 3.13.01.03

Compatt 6+ LBL Transponder (DAS) 2.06N

MiniROVNav 6+ 3.12.02.05
MicroCompatt 6+ 3.12.02.05

Lodestar Gyro Compatt 6+ (CPU) 3.12.07.13

Lodestar Gyro Compatt 6+ (Lodestar) 3.02.01

Software

The following associated software versions have been tested with this release. As a minimum, these versions must be
installed when used with this release of Fusion 2:

Package

Janus

Software Version
1.06.01.14

New Features

Ref

34845 | Instrumentation Adds a warning to the use if ZDA time-sync input is detected to be
incompatible with current settings

34857 | User Interface Adds acoustic diagnostics information to ranges in measurements
window

34860 | Instrumentation / Ul Add alarm to inform when unable open a com port.

34863 | Instrumentation Enable system to connect to a SPRINT which has been reset to factory
defaults

34868 | Database / Data Logging Adds expanded tools for database management

34871 | Calibration / Ul Provides a reminder to export data after completion of a calibration.

34874 | User Interface / Acoustics New range diagnostics tool

34877 | User Interface / Acoustics New telemetry diagnostics tool

34897 | Instrumentation Adds decoder for WINSON telegrams providing depth information.

34898 | Instrumentation Enables logging of new INS diagnostic messages for use in post-
processing

34899 | Instrumentation Updated default values for some INS parameters in SPRINT
configuration files.

34900 | Instrumentation Allow the use of an external depth sensor with a SPRINT-Nav

34927 | Instrumentation More detailed time-sync information in SPRINT data tab

34992 | Application Start-up Prevents Fusion2 from being opened if SPRINT software is running to

prevent SPRINT instrument configuration conflicts.
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34868 Expanded Tools for Database Management

More advanced tools for the management of the MongoDB database to which all Fusion2 data is logged are now
provided. The new capabilities allow the user to:

e See in more detail the size and extents of the database

e Archive an entire database for backup or replication purposes.
e Restore an archived database

e Delete all, or selected portions of, the data within the database.

Basic database information can be viewed by opening the Tools > Options window. Further information and
management tools can be found by clicking on the Data Management button as show below.
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Statistics, archival and deletion options are presented as shown below.
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34874 New Range Diagnostics Tool

A new range diagnostics tool is available and can be
opened via the View> Diagnostics > (Vehicle) > Ranges
menu item.

The tool displays information about each acoustic range which is expected to be received by the transceiver on the
selected vehicle, and their use in the selected positioning solution. The solution for which information is displayed
can be changed using the drop-down menu at the top of the tool window.

Range received but
rejected by positioning
solution

Ranges received and
used in solution

Range received but
not configured for use

Range not received
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34877 New Telemetry Diagnostics Tool

A new telemetry diagnostics tool is available and can be opened via the View>
Diagnostics > Telemetry menu item.

Alternatively, the tool can be opened by clicking on the popup telemetry indicator which
appears when telemetry tasks are being carried out.

The tool provides a dynamic overview of all acoustic telemetry tasks as they are queued and actioned, together with
their status, the results of the tasks and associated acoustic signal quality information.

Received Fixed Settings - UID:4661, FL:825A, FW:3.12.00.01, OMNI, Sensors{T, SV, PR] #  Step Complete

Received Battery Status - 75% +" Step Complete

Received Acoustic Settings - TAT200, BLK100, RXW4800, TXW100, NPL187, TPL187, LG26, CIS00, ATS,

Enabled, EC1 Step Complete

Received Unit Settings - SN22224-011, DR2000, STD, ALG6082, 1, TYPE: 8300 Step Complete

Retrieve All Settings 8 Pending

e S U e KT oo

M Cx

15:53:08 Transceiverl Read Sensors %" Complete

A history of the acoustic telemetry tasks displayed in this tool is automatically recorded to file for further analysis if
required. These files can be found in
C:\Users\Public\Documents\Sonardyne\Fusion2\LogFiles\TelemetryDiagnosticsLog.
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34900 Allow the use of an external depth sensor with a SPRINT-Nav

It is now possible to connect an external depth sensor to a Fusion 2 system which is using a SPRINT-Nav and use it for
INS depth aiding. This provides an alternative to the built in SPRINT-Nav pressure sensor.

The SPRINT-Nav and external depth sensor should be added to the vehicle via the system setup page in the usual
way:

The desired depth sensor should be selected for use in the appropriate solution in the Navigation Solutions
configuration window:
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34927 More Detailed Time-Sync Information in SPRINT Data Tab

Information about the estimated SPRINT time synchronisation quality and the time since last update is now shown in
the SPRINT data tab:
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Bug Fixes
For more details on any of the fixes below please contact Sonardyne customer support.

Functional Area Description

Tracking 34788 Fixes issue which prevented SV profile being read correctly for
some system configurations.

User Interface 34855 Fixes issue which prevented a manual sound speed being
entered for a vehicle.

User Interface 34865 Several detail fields not being populated for SPRINT and Syrinx
instruments, despite successful instrument connection.

Security Key 34848 Fixes issue which prevented features from multiple security keys
being used concurrently.

Instrumentation 34859 Prevents multiple instruments being added to a communication
port when doing so would result in a conflict.

Instrumentation 34862 Fixes issue which prevented ZDA time-sync being sent to SPRINT
instrument

Instrumentation 34864 Improves stability of SPRINT reconnection procedure after
instrument is rebooted

Instrumentation 34872 Fixes issue with automatic configuration of power pass-through
on SPRINT ports for DVL instruments and Transceivers

User Interface 34884 Improves reliability of power pass-through indicators for SPRINT
ports.

Instrumentation 34866 Prevent sending of further commands to SPRINT instrument
when a reset or shutdown command has been issued.

Instrumentation 34887 Remove obsolete and unnecessary commands from SPRINT
default configuration files.

User Interface 34888 Fixes bug which prevented INS heading quality from being
plotted on chart

Instrumentation 34901 Prevents sending of unnecessary multi-user commands by
systems which don’t require multi-user features.

User Interface 34903 Fixes issue which prevented alarm being raised when no
heading available in LBL positioning solution.

Beacon Import 34904 Fixes issue which prevented CSV import of beacons when
elements of beacon configuration missing.

Instrumentation 34905 Fixes issue which prevented configuration of some Compatt
parameters while tracking enabled.

Instrumentation / Tracking 34906 Fixes issue which prevented correct use of SV profile during box-
in calibration

Instrumentation 34911 Fixes issue which prevented use of PSONDEP telegram for depth
aiding via SPRINT port

User Interface 34915 Improved wording for missing DVL calibration alarms.

User Interface 34920 Fixes issue with visual scaling of data in the text-display

User Interface 34931 Fixes issue preventing correct charting of AHRS data from
SPRINT instrument

Outputs 34939 Fixes issue preventing output of DigiQuartz depth data via
SPRINT serial port.

User Interface 34943 Fixes display of available job files when opening an existing job
file.

User Interface 34946 Fixes issue which caused the DVL status in the Navigation Status
display to show good (green) when no data was being received.
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Functional Area

Description

Calibration reprocessing 34951 Fixes incompatibility with old versions of CAS2 files produced by
Ranger 2 software, which prevented them from being imported
for box-in reprocessing in Fusion 2.

User Interface 34954 Changes time display in average fix tool from 12 to 24 hr format.

Instrumentation 34955 Fixes issue which caused a failed Compatt configuration
command to be repeated indefinitely if ranging was enabled
and active.

Tracker 34956 Fixes issue which could prevent correct remote point to be
output for an LBL solution

Instrumentation / User Interface 34957 Prevents user from changing beacon addresses and/or wakeup
tones when ranging is enabled and active.

Instrumentation 34961 Prevents crash which could occur during retrieval of
GyroCompatt status.

Instrumentation 34963 Fixes issue which prevented beacon configuration to be changed
while tracking on a multi-user channel.

Instrumentation 34965 Fixes issue which could prevent successful INS aiding of SPRINT
connected via serial-ethernet device.

Instrumentation 34968 Corrects rendering of beacon sensor data in measurement
display when the beacon reports a sensor error.

Instrumentation 34969 Fixes issue which prevented reopening of NSH serial ports when
the device was rebooted, or the connection was lost and
regained.

Baseline Calibration Collection 34977 Fixes issue which prevents baseline calibration from starting.

Alarms 34988 Fixes issue in which some alarm fields were left unpopulated

Tracking 34994 Prevents output of LBL position derived from fewer than 3
ranges.

User Interface 34995 Corrects information shown in comms viewer when in
Observation mode when an output telegram can’t be sent.

Instrumentation 34996 Prevents a resetting transceiver from overwriting the currently
configured SV collection settings.

Outputs 34999 Ensures that the ‘not limited’ option is presented as the default
when configuring an LBL derived output telegram.

User Interface 35000 Fixes issue which could cause some ranging segments in the
navigation status display to show data from previous ranging
cycle.

Outputs 35004 Fixes incorrect timestamp format in GGA output telegram.
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Contact Information

For further support please contact:

24/7 Emergency Helpline

T. +44 (0) 1252 877600

Email Support

support@sonardyne.com

Website

www.sonardyne.com

39



